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Before Installing v3.1 
Microsoft Internet Explorer v5.x or later is required to be installed before installing 
Predator DNC v3.1.  To simplify this requirement, we have included IE v5.5 as part of the 
installation processes. 

NOTE: Existing customers who have both DNC v3.0 and MDC v1.0 must upgrade both 
products to DNC v3.1 and MDC v1.1. 

Backup everything; especially your PXP or PSF file.  Running v3.1 will upgrade the files 
from v3.0 to v3.1 and it will no longer be compatible with v3.0.  Predator DNC will always 
be forwards compatible.  

Why v3.1? 

By design, this release was intended to be a maintenance release to v3.0. Along the way 
we ended up adding about 100 new features and improvements.  Details of the major 
new features are explained though out this document.  

Installing v3.1 
One of the biggest changes is a new installation process based on Microsoft’s Install 
Services.  This technology was introduced in Windows 2000.  If you are running Windows 
95, 98 or NT v4.0, and Microsoft’s Install Services has never been installed, v3.1 will do 
this automatically at the very beginning.  This will require a re-boot prior to completing the 
installation of Predator DNC.  

By default installation occurs in the \program files\predator software\dnc 3.1\ directory.  If 
you were running v3.0 simply proceed with the installation normally.  If you were running 
a beta version of 3.1, please un-install it prior to installing v3.1. 

With this release we have dropped supporting floppy drive or diskette based installs.  All 
installations must be performed from a CD, CDR, CDRW or DVD drive. 
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Network Installations of v3.1 

Another major installation improvement has been made with network installations.  By 
committing to store the product installation on a server, users will enjoy automatic healing 
of all critical files upon running Predator DNC.  For example, a user accidentally deletes 
pdnc.exe. Under normal circumstances he would be down and the software would fail to 
run.  With v3.1 when the user double clicks the desktop shortcut all critical files are 
checked and if necessary restored from the network server and the software begins to 
run automatically. 

The easiest way to perform a network installation is to step through the following: 

1. Copy the contents of the \dnc directory on the CD to a \setup\dnc 3.1\ or similar 
directory. 

2. Run the setup.exe from the \setup\dnc 3.1\ directory. 

NOTE: Should any automatic healing be necessary, Predator DNC will be able to 
automatically extract the necessary files from the appropriate cab files stored in the 
\setup\dnc 3.1\ directory.  If you install from a CD, Predator DNC will be forced to prompt 
for the CD. 

 
What’s New in v3.1? 

New! HTML based Online Help 

New HTML based, context sensitive, online help is now fully integrated throughout 
Predator DNC.  Pressing F1 at any time can access over 250 pages of online help.  
Every object also includes online help.  Additionally, help buttons are in the lower left 
hand corner of every dialog box. This new help system provides a complete reference for 
the entire application and replaces a traditional bound and printed reference manual.  
Several printing options are included to print individual pages, topics, and sub-topics. 

New! Remote Messages 
Over 20 user configurable remote messages have been added to the machine wizard.  
Remote messages can be configured to be CNC programs and sent to the CNC.  An 
example remote message would be the following: 

O1 (FILE NOT FOUND) 
M30 

Remote messages can be configured with variables for even better shop floor feedback.  
Variables include filename, date, size and pathname.  An example remote message with 
variables would be the following: 

O1 (JOB123.NC SAVED IN 4075 BYTES) 
M30 

In addition error messages can send email messages or be tracked via ASCII, HTML, 
Excel, Access or Oracle. 
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New! Predator DNCXpress 
A new entry-level DNC solution Predator DNCXpress is now available stand alone or 
within Predator DNC.  When purchased stand alone Predator DNCXpress is bundled with 
a USB hub and a single grizzly cable.  Predator DNCXpress is designed and priced for 
small shops with RS-232 based Fanuc compatible CNCs and is available in 4 port and 8 
port configurations.  If additional networking features or more CNC machines per PC are 
required Predator DNC or Predator Desktop should be purchased.  Predator DNCXpress 
is backwards compatible with Cell or PSF files from previous versions of Predator DNC.  
Predator DNCXpress has been enhanced with an updated user interface, support for 
copying and pasting of machine icons, advanced timeouts command and additional 
constants for Send and Receive timeouts. 

New! X_Net Technology Integration 
In November of 2000, Predator Software acquired the X_Net series of shop floor 
products.  Version 3.1 of Predator DNC is the first release to include X_Net technology.  
Predator Software is aggressively integrating the entire suite of X_Net products within the 
Predator product line. 

Enhanced! Windows Compatibility 
Although Windows NT v4.0 remains the preferred platform for most of our customers. 
V3.1 of Predator DNC has been extensively tested with a wide range of hardware under 
Windows 2000 and Windows ME. 

New! Search Sub Directories 

A new option to search sub directories has been added to the command wizard. With this 
option enabled, remote request commands will first start in the default directory and if the 
file is not found, Predator DNC will then continue on searching through each sub 
directory in alphabetical order.  In addition, directory shortcuts can be placed within the 
default directory and if the search sub directories option is enabled, Predator DNC will 
automatically search the directory shortcut as well. 

Enhanced! Cancel 
Predator DNC’s cancel command has been simplified if the machine’s multiple 
commands option is disabled.  If the machine’s multiple command option has been 
enabled, multiple Cancel commands will be available to the user. Finally, canceling an 
active command is now more compatible with greater number of operating systems, 
device drivers, settings and their combinations. 

Enhanced! Right Mouse Menus 

Right mouse menus have been enhanced making Predator DNC even easier to use.  
Individual object properties can be edited via the right mouse menu.  Send to CNC and 
other user definable commands have been added to right mouse menus to file objects 
when they are located under a machine icon.  Right mouse menus in shop floor mode 
have been enhanced with options for Open, Edit and Virtual CNC and they can be 
controlled with security. 

Enhanced! Menus 
Menus within DNCXpress and the Job files have been updated to be more compatible 
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with DNC Explorer. 

Enhanced! CNC Program and Text File Viewing 
CNC program and text file viewing has been improved when scrolling to the bottom of a 
file and the left hand margin has been increased for better readability.  In addition, it is 
more compatible with the Predator Editor. 

New! Basic, Intermediate and Advanced Options 
From the Options menu Basic, Intermediate and Advanced options configure the number 
of objects displayed in the command wizard.  As additional objects get added to Predator 
DNC these options simplify the number of appropriate choices. 

New! Number of Backups 

The number of backups can now be configured in the command wizard. Predator DNC 
will automatically maintain 1 – 9999 backups versions of each CNC program. 

New! Machine Status Icons 
Every command can now toggle persistent machine status icons.  Currently green, yellow 
and red status icons can be configured for each command.  Intended for use when 
Predator DNC is used in conjunction with Predator MDC. 

New! Zip Folders 

Zip files can now be added to DNC explorer as a live Zip folder.  Similar to live folders, 
Predator DNC will update the listing and the files based on the latest changes made to 
the ZIP file.  This allows CNC programmers or third party applications to update a ZIP file 
for use on the shop floor.  Predator DNC will automatically use the latest instance of the 
ZIP file and it’s zipped files. 

New! Text File Icons 
Text files including CNC programs can now be added to machine and group icons for 
work instructions, tool lists, setup sheets, etc.  These can be viewed at any time within 
the preview section.  In addition you can drag and drop them onto machine icons to 
execute any commands. 

New! Fanuc Cassette Object 
Predator DNC now supports the Fanuc cassette protocol.  Users that only need remote 
upload and download and store their CNC programs by O numbers can simplify the 
required number of steps for shop floor personnel. 

New! Brother Conversational Object 

Predator DNC now supports the Brother conversational protocol.  Data is stored in a 
binary format and cannot be edited with the Predator CNC Editor. 

New! Fagor Object 
Predator DNC now supports a new remote style Fagor protocol for the 8050 series. 

New! Kermit Object 
Predator DNC now supports the Kermit communications protocol can be used on Tarus 
and other Kermit compatible CNC controls. 

New! LSV2 Object 
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Predator DNC now supports the LSV2 protocol for the Deckel Dialog 10 and 11 series 
control. 

New! SMT Object 

Predator DNC now supports the SMT protocol for Swedish Machine Tools. 

New! Object Debugger Object 

Predator DNC now provides a low level diagnostic tool to trouble shoot new protocols or 
complicated machine setups.  It should only be used by experienced service personnel 
and the results can be forwarded to Predator personnel as needed. 

New! Okuma Object 
Predator DNC now supports a simplified Okuma protocol. 

Enhanced! Clean Code Object   
The Clean Code object has been enhanced with greater support for European based 
CNC compatibility and flexibility. 

Enhanced! Command Line Object   

The Command Line object has been enhanced to be compatible with Windows 2000. 

Enhanced! Delete Sequence Numbers Object   

The Delete Sequence Numbers object has been enhanced with an option to ignore 
comments and the sequence numbers and comment definitions are now done within the 
machine object. 

Enhanced! FTP Object   
The FTP object has been enhanced with better error messages, increased CNC control 
compatibility and automatic Windows compatible directory management. 

Enhanced! HHT Object   

The Predator HHT object has been enhanced to work when the multiple tasks per 
machine option is enabled. 

Enhanced! HTML Table Object   
The HTML Table object has been renamed and enhanced to automatically output HTML 
tables vs. an HTML list. 

Enhanced! MDC Objects 
The MDC objects have been enhanced to work with Predator MDC v1.1 in addition they 
have been improved for easier setup and configuration.  Extensive online help for MDC 
objects has also been added.   

NOTE: Existing customers who have both MDC v1.0 and DNC v3.0 must upgrade both 
products to MDC v1.1 and DNC v3.1. 

Enhanced! Remote Directory Object   

The Remote Directory object has been enhanced with improved sorting and automatic 
uppercase conversion for all directory listings. 

Enhanced! Remote Autoname Object   
The Remote Autoname object has been enhanced to optionally ignore comments. 
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Enhanced! Remote Request Object   
The Remote Request object’s remote send delay property is now defined within the 
machine object and is also used for remote messages. 

Enhanced! Restart via Remote 
The Restart object has been improved to support remote request.  Within the object a 
checkbox configures whether the restart object will interactively prompt or should execute 
automatically for remote.  An example remote message would be the following: 

O1 (DNC JOB123.NC T3) 
M30 

Predator DNC will automatically search through the JOB123.NC file for the first T3 and 
will automatically skip the beginning of the file and begin sending from the T3 block.  If 
additional information needs to be automatically added to the beginning of the file a Send 
Events object can be added after the Restart object. 

Enhanced! Command Wizard 
The Command wizard has been enhanced with an updated Paths step and the Object 
Manager step automatically honors the Basic, Intermediate and Advanced object levels. 
A bug introduced in v3.0 has been fixed so new objects can be inserted as needed 
without resetting existing object properties to their default values.  Finally, advanced 
users can skip the Command wizard to edit individual object properties with a single right 
click.  

Enhanced! Machine Wizard 

The Machine wizard has been enhanced with more options and a new Message 
Manager.  Finally individual remote messages can also be edited within the Machine 
wizard.  

Enhanced! Live Folders 
Live Folders in v3.1 are now exponentially faster then in v3.0. Finally, Security and object 
permissions have been enhanced to support live folders.  In addition, live folders can be 
copied and pasted. 

Enhanced! Open and Save Dialogs in Shop Floor Mode  
Open and Save dialogs are re-designed to be easier to use and are also exponentially 
faster then in v3.0.  Finally Open and Save dialogs will automatically sort any sub-
directories. 

Enhanced! Security 

Several security features have been enhanced including an updated login dialog, support 
for live folders, and improved saving of security options. 

Enhanced! Demo Mode 
An updated demo mode now equivalent to a DNC/1 with support for CNC program up to 
50 lines is included with every demo license. 

Enhanced! Zinger Example PXP 
Updated Zinger example PXP for v3.1 of Predator DNC. 
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Enhanced! Machine Error Message Display 
Displaying error messages per machine has been enhanced so they are sorted in 
descending date and time order.  In other words, the most recent error is listed first. 

Enhanced! Help About 
An updated help about dialog has been added with a new system info button.  The 
system info button will query the PC and Windows for troubleshooting and diagnostic 
information. 

Enhanced! Icons 
Updated document, command, machine, file, folder, and live folder icons have been 
improved or added through out the application. 

New! Getting Started Manual 
A new getting started manual is now available for new users of Predator DNC. 

NOTE: Any v3.0 users of Predator DNC or Predator Desktop that upgrade to v3.1 may 
see 19 dots in the toolbar or see extra large toolbar heights.  To fix this problem select 
Customize from the Options menu and then click the Reset button.  Click the OK button 
to exit the Customize dialog and then select Save Layout from the File menu. 

For more information 

For the latest information on Predator DNC, check our web site at 
http://www.predator-software.com 

 
 


